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Hinweise zu diesem Handbuch 

Mit diesem Handbuch erhalten Sie Hinweise und Informationen über die Funktion und Konfigura-
tion des MasterPort RM.  

 

Dieses Handbuch gilt für den MasterPort RM. Wie alle anderen Produkte aus dem Hause LSS 
GmbH unterliegt der MasterPort RM einer ständigen technischen Weiterentwicklung. Deshalb 
werden hier unter Umständen Funktionen und Einstellungen beschrieben, die für den von Ihnen 
genutzten MasterPort RM nicht verfügbar sind. 

Dieses Handbuch nutzt folgende Symbole, um für Sie wichtige Hinweise zu Ihrer Sicherheit und zur 
Konfiguration kenntlich zu machen. 

 

Hier erhalten Sie zusätzliche Informationen.  

 

 

Ein Achtung weist Sie auf Situationen hin, in denen Entscheidungen zu technischen 
Problemen mit dem Gerät oder zu Datenverlusten führen können. 

 

 

Eine Warnung bezeichnet Situationen, in denen Verletzungen oder Schäden für Leib 
und Leben auftreten können. 

 

 

Sicherheitshinweise 

Der Umgang mit dem MasterPort RM ist nicht gefährlich. Schutzisolierung und weitere Sicher-
heitsmaßnahmen verhindern zuverlässig, dass Sie mit gesundheitsschädlichen Spannungen und 
Strömen in Berührung kommen. Beachten Sie aber folgende Hinweise: 

 

 Nehmen Sie niemals sichtbar beschädigte Geräte in Betrieb! 

 Liegt der Verdacht auf einen Defekt vor, trennen Sie das Gerät sofort von der 
Stromversorgung! Sichern Sie das Gerät gegen Wiederinbetriebnahme! 

 Trennen Sie vor der Abnahme der Rückwand das Gerät unbedingt vom Netzteil! 

 Reparaturen dürfen nur von einem autorisierten Händler oder von Mitarbeitern der 
LSS GmbH durchgeführt werden. 
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Hinweise zur Handhabung 

Der MasterPort RM ist für einen 24h Dauerbetrieb konzipiert. Dennoch sollten Sie folgendes be-
achten:  

 

 Setzen Sie das Gerät nur zu seinem bestimmungsgemäßen Zweck ein! 

 Vermeiden Sie extreme mechanische Belastungen! 

 Vermeiden Sie jegliche mechanische Einwirkungen auf das Display! 

 Wenn nötig reinigen Sie das Display ausschließlich bei ausgeschaltetem Gerät. Be-
nutzen Sie nur ein angefeuchtetes Tuch 

 Vermeiden Sie direkte Nässeeinwirkung sowie übermäßige Hitzeeinwirkung auf das 
Gerät! 

 Decken Sie die Belüftungsöffnungen niemals ab! Brandgefahr! 

 Montieren Sie das Gerät nicht unmittelbar über Scheinwerfern! 
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Überblick 

Der LSS MasterPort RM ist ein Netzwerkknoten für das anspruchsvolle Lichtnetzwerk. Er ist voll 
RDM-fähig und unterstützt den RDM-Traffic aller angeschlossenen Geräte. Durch RDM wird eine 
effektive und leicht zu realisierende Hardwarediagnose der angeschlossenen Hardware ermög-
licht. 

 

Der LSS MasterPort RM ist mit einer Doppel-CPU mit hoher Leistungsfähigkeit ausgestattet, die 
DMX- und RDM-Signale getrennt voneinander verarbeitet. Dadurch wird stabiles, qualitativ hoch-
wertiges DMX-Signal auch bei gleichzeitiger RDM Signalverarbeitung erzeugt. Fehlerhafte Signale 
sind damit ausgeschlossen. 

 

Der LSS MasterPort RM verfügt über ausgeprägte Mergefähigkeiten. Er verfügt neben einem 
Ethernet-Anschluss über einen DMX-In und zwölf DMX-Anschlüsse. Die zwölf Anschlüsse können 
einzeln frei als In- oder Out-Anschlüsse definiert werden. Gleichzeitig können die Anschlüsse auch 
gruppiert werden; definierte Out-Anschlüsse werden einem definierten In-Port zugeordnet. Somit 
sind bis zu zwölf ausgehende oder bis zu dreizehn eingehende Universen möglich. Die DMX-
Anschlüsse können wahlweise als RJ45- oder als 5pin XLR-Anschlüsse ausgeführt werden 

Neben DMX 512 unterstützt der MasterPort RM alle gängigen Netzwerkprotokolle wie sACN und 
ArtNet, sowie AVAB/IPX, AVAB/UDP und ShowNet. 

 

Die Stromversorgung des LSS MasterPort RM kann wahlweise über 230V Netzanschluss oder über 
Power-over-Ethernet erfolgen. Zur Betriebssicherheit können auch beide Arten der Stromversor-
gung angeschlossen sein. In diesem Fall hat Power-over-Ethernet Priorität gegenüber der Netzver-
sorgung. 

 

 

Ein Gerät – zwei Bauformen 

Der MasterPort RM ist in zwei Bauformen erhältlich. Das 19‘‘ Einbaugerät ist speziell für feste 
Rack-Systeme konzipiert. Die portable Version des MasterPort RM bietet die Funktionalität des 
Einbaugerätes für den mobilen Einsatz. 
 
 
  
 
 
 
MasterPort RM 19 Zoll       MasterPort RM portable 
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Funktionsübersicht 

DMX 

Anschlüsse 

Der LSS MasterPort RM verfügt über freidefinierbare und festdefinierte DMX-Anschlüsse. Der 
DMX-In und der DMX-Thru sind fest definiert. Die Anschlüsse 1 bis 12 können frei als Aus- oder 
Eingänge definiert und konfiguriert werden.  

 

DMX-Ausgänge 

Sind ein oder mehr Anschlüsse 1 bis 12 als DMX-Ausgänge definiert, können für jeden Anschluss 
folgende Parameter eingestellt werden: 

 

 Timeout-Zeiten oder Halten des letzten Protokolls 

 Empfangs-Universe 

 Merge-Modus 

 Sende-Universe mit Angabe der Priorität 

 DMX-Startcode und Protokolllänge 

 Breaklänge 

 Mark After Break 

 Mark Before Break 

 Mark Between Slots 

 

Dadurch können Sie den MasterPort RM an jedes Endgerät anpassen. 

 

DMX-Eingang  

Die DMX-Anschlüsse des MasterPort RM sind mit einem FPGA ausgestattet, der selbstständig alle 
DMX-Parameter nach ANSI E1.11 erkennt und die Eingänge entsprechend einstellt. Weiterhin werden 
die DMX-Signale durch den Controller aufbereitet und ausgewertet.  
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Ethernet 

Datentransferrate 

Der MasterPort RM zeichnet sich durch hohe Durchsatzrate und geringe Latenz (Verzögerungszeit) 
in beiden Richtungen aus. Die Netzwerkschnittstelle ist 100MBit-fähig und die interne CPU arbei-
tet mit einem sehr schnellen Realtime-Multitasking-Betriebssystem. So ist ein maximaler Durch-
satz von >1000 Netzwerk-Paketen pro Sekunde möglich. 

 

Auswahl des Ethernet-Switches 

Wird der MasterPort RM mit dem Netzwerkprotokoll sACN eingesetzt, so kann die Netzwerkbelas-
tung für ihn und andere Netzwerkteilnehmer sehr effektiv gesenkt werden, wenn man manage-
mentbare Switche einsetzt, die das sogenannte "IGMP Snooping" beherrschen. 

 

Derartige Switche erkennen, welche Universes die Geräte an jedem Switch-Port benötigen und 
schalten dann nur diese Universes zu den jeweiligen Geräten durch. 

 

Licht-Netzwerkprotokolle 

Der LSS MasterPort RM unterstützt folgende Licht-Netzwerkprotokolle: 

 

 sACN  Art-Net  ShowNet  AVAB/UDP  AVAB/IPX 

 

Das Standard-Netzwerkprotokoll des MasterPort RM bei Auslieferung ist sACN nach Standard ANSI 
E1.31.  

 

Netzwerkeinstellungen 

Folgende Parameter sind einstellbar: 

 

 separate Einstellung von Licht-Sende- und Empfangsprotokoll 

 Verhalten bei Ausfall der letzten Empfangsquelle (Timeout, Hold) 

 Licht-Senderate (bei Leerlauf ohne Datenänderung) 

 IP-Adresse  Manuell / Art-Net 2.x.x.x / Art-Net 10.x.x.x / DHCP 

 IP-Subnetz-Maske 

 Gateway-IP 

 SLP Netzwerkprotokoll nach RFC2608 (SLP V2) 

 RDM-Net Netzwerkprotokoll nach ANSI 1.37 

 Einschaltung der Sende- und Empfangschecksummenprüfung 

 Einstellung der Ethernet-Geschwindigkeit und des Duplex-Mode 
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Merge-Verhalten 

Der MasterPort RM kann bei Anlagen, die auf dem gleichen Subnetz/Universe im Ethernet senden, 
bis zu 3 Anlagen HTP-mergen. Es werden ebenfalls Prioritäten unterstützt, wenn dies das Lichtpro-
tokoll zulässt. Es werden momentan keine herstellereigenen Erweiterungen, wie z.B. „Prioritäten 
pro Kreis“, unterstützt. 

 

 

Remotekonfiguration 

Für alle LSS-Geräte wird die kostenlose Software ConfigCore empfohlen, die alle Features des Mas-
terPort RM und anderer LSS-Geräte, aber auch Art-Net-Geräte anderer Hersteller unterstützt. Nur 
mit dieser Software ist es möglich, alle Geräte im Netzwerk aufzufinden und den MasterPort RM 
komplett remote zu konfigurieren. 

 

Als Art-Net-kompatibles Gerät arbeitet der MasterPort RM problemlos mit Art-Net-Softwaretools 
anderer Hersteller, wie z.B. dem Programm DMX-Workshop zusammen (Download unter 
www.artisticlicence.com). Selbstverständlich hat der MasterPort RM wie alle anderen Art-Net-
Geräte eine eigene OEM-ID (ab Workshop-Version 3.57 erkannt und unterstützt). Über dieses Tool 
ist auch eine eingeschränkte Remote-Konfiguration möglich. Beachten Sie, dass Art-Net hier nur 
eine Untermenge des MasterPort RM konfigurieren kann.  

 

Auch bei anderen eingestellten Licht-Protokollen als Art-Net ist der MasterPort RM mit 
ConfigCore immer konfigurierbar, es wird lediglich vorausgesetzt, dass der PC im IP-
Adressbereich des MasterPort RM liegt. 
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Anzeige-, Anschluss- und Bedien-
elemente 
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MasterPort RM 19 Zoll 

Überblick Frontseite 

Auf der Frontseite des LSS MasterPort RM 19 Zoll befinden sich die DMX-Anschlüsse und die Be-
triebsanzeigen. 

 

Freidefinierbare  

DMX-Anschlüsse 

 
 

Betriebsanzeigen 

und Taster 

 

Festdefinierte 

Anschlüsse 

 

 

DMX-Anschlüsse 

Der LSS MasterPort RM 19 Zoll kann mit DMX-Anschlüsse im 5polig XLR oder RJ45-Design ausge-
stattet werden. Die freidefinierbaren Anschlüsse können in der Menüsteuerung als Ein- oder Aus-
gänge festgelegt werden. Oberhalb der Anschlüsse wird der Betriebszustand mit LEDs angezeigt: 

 

LED Farbe Bedeutung 

Anschluss als 
DMX-In defi-
niert 

Gelb Ein: Datenempfang 

Flackern: RDM ist aktiv 

Blinkt: dauerhaft fehlerhaftes Protokoll 

Aus: keine Datenempfang 

Anschluss als 
DMX-Out de-
finiert 

Gelb Ein: Daten werden gesendet 

Flackern: Hold aktiv  – kein Empfang von Daten, letzte empfangene 
Daten werden weiter gesendet 

Blinkt: RDM aktiv 

Aus: DMX-Out ist abgeschaltet 
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Ethernet Anschluss 

Oberhalb des Ethernet-Anschlusses wird der Betriebszustand mit LEDs angezeigt: 

 

LED Farbe Bedeutung 

Speed Grün Ein: Es besteht eine Datenverbindung mit 100MBit/s. 

Aus: In Verbindung mit Link-LED 

Link Gelb Ein:  Es besteht eine Datenverbindung. Ist die Speed-LED gleich-
zeitig aus, besteht eine Datenverbindung von 10MBit/s. 

Flackern: Daten werden übertragen. 

Aus: Sind Link- und Speed-LEDs aus, besteht keine Ethernet-
Verbindung. 

 

Betriebsanzeigen 

Über die LEDs an der Frontseite werden die Betriebszustände des LSS MasterPort RM 19 Zoll ange-
zeigt. 

 

LED Farbe Bedeutung 

Power blau Ein: Betriebsspannung vorhanden 

Aus: Betriebsspannung nicht vorhanden 

ACTIVE/FAIL  DMX-Port-Sammelanzeige  

Grün Flackern: Es liegen aktive UND gerouteten Netzwerk -Universen an 
(egal ob Empfang oder Senden) 

Ein: DMX-Ports  

Blinkt: Gerät wird über ConfigCore oder RDM identifiziert 

Aus: Alle DMX-Anschlüsse sind aus 

Orange Blinkt: Warnmeldung 
Gerätetemperatur ist höher als 75°C 

Rot Nur Fehlermeldungen 

Flackert: Nur beim Start – keine Fehlermeldung 

Blinkt: Gerätetemperatur ist höher als 80°C - Akustisches Warn-
signal ertönt 
Lüfter prüfen und Gerät ausschalten! 

An: Sammelfehler – Service informieren! 

 

Im Gerät sind noch weitere Diagnose-LEDs vorhanden. Diese sind für Service und Wartung vorge-
sehen. 
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Taster 

Auf der Frontseite des MasterPort RM befinden sich ein Reset- und ein Init-Taster, mit denen das 
Gerät ohne Menüzugang zurückgesetzt und Default-Werte geladen werden können. 

 

Taste Zeit des Drückens Rückmeldung Bedeutung 

Reset < 3s keine Neustart des MasterPort RM 

> 3s keine Neustart des MasterPort RM mit Neu-
start des FPGA 

Init < 3s Kurzer Signalton Selbsttest 

> 3s Langer Signalton Laden der Default-Werte 

Nach Reset und während 
des Bootvorgangs 

Disharmoni-
scher Signalton 

Laden der Default-Firmware (Backup 
einspielen) und aller Default-Werte 

 

 

 

 

Rückseite 

Stromversorgung über PoE und Netzanschluss 

Die Spannungsversorgung der Steuereinheit des MasterPort RM kann wahlweise per Power-over-
Ethernet (PoE) oder mit einem externen Netzanschluss erfolgen. In der PoE-Variante wird die 
Stromversorgung kann durch sogenannte Endspan-Devices (z. B. direkt PoE-fähige Switches) oder 
Midspan-Devices (Einheiten zwischen Switch und Endgerät) sichergestellt.  

 

Der Netzanschluss wird rückseitig über einen Kaltgeräteanschluss (IEC 60320-C14) realisiert.  

 

 

Ist der MasterPort RM sowohl an PoE-fähiges Device und an eine externe Spannungs-
versorgung angeschlossen, hat die Versorgung über PoE Priorität. 
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MasterPort RM portable 

Überblick 

Der LSS MasterPort RM portable besitzt die gleichen Anschlussmöglichkeiten wie das 19 Zoll Gerät. 
Allerdings sind die Anschlüsse anders angeordnet. 

 

DMX-In/-Thru 

 

Menü- & 

Einstellbereich 

 
 

Strom- 

versorgung 

 

Freidefinierbare 

DMX-Anschlüsse 

 

Taster 

 

Ethernet 
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Menü- und Einstellbereich  

Wie der LSS MasterPort RM 19 Zoll wird auch der MasterPort RM portable über die Software LSS 
ConfigCore konfiguriert. Das Gerät ist für den mobilen Einsatz entwickelt worden und bietet aus 
diesem Grund zusätzlich auch ein On-Device-Menü, das sich auf der Oberseite des Gerätes befin-
det.  

 

Betriebsanzeigen 

 

 
 

Menübildschirm 

 

Dreh/Drück-Encoder 

 

 

Verwenden Sie den Bildschirmschoner! Dies verlängert die Lebensdauer des Displays um 
ein Vielfaches.  
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Betriebsanzeigen 

 

LED Farbe Bedeutung 

Power blau Ein: Betriebsspannung vorhanden 

Aus: Betriebsspannung nicht vorhanden 

LINK/DATA gelb Ein: Ethernet-LINK, keine Daten 

Blinkt: Ethernet-LINK, Daten 

Aus kein LINK 

ACTIVE/FAIL  DMX-Port-Sammelanzeige  

Grün Flackern: Es liegen aktive UND gerouteten Netzwerk -Universen an 
(egal ob Empfang oder Senden) 

Ein: DMX-Ports  

Blinkt: Gerät wird über ConfigCore oder RDM identifiziert 

Aus: Alle DMX-Anschlüsse sind aus 

Orange Blinkt: Warnmeldung 
Gerätetemperatur ist höher als 75°C 

Rot Nur Fehlermeldungen 

Flackert: Nur beim Start – keine Fehlermeldung 

Blinkt: Gerätetemperatur ist höher als 80°C - Akustisches Warn-
signal ertönt 
Lüfter prüfen und Gerät ausschalten! 

An: Sammelfehler – Service informieren! 

 

 

Ethernet Anschluss 

Oberhalb des Ethernet-Anschlusses wird der Betriebszustand mit LEDs angezeigt: 

 

LED Farbe Bedeutung 

Speed Grün Ein:  Es besteht eine Datenverbindung mit 100MBit/s. 

Aus:  In Verbindung mit Link-LED 

Link Gelb Ein:   Es besteht eine Datenverbindung. Ist die Speed-LED  
  gleichzeitig aus, besteht eine Datenverbindung von  
  10MBit/s.  

Flackern:  Daten werden übertragen. 

Aus:  Sind Link- und Speed-LEDs aus, besteht keine Ethernet- 
  Verbindung. 
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DMX-Anschlüsse 

Der LSS MasterPort RM portable kann mit DMX-Anschlüsse im 5polig XLR oder RJ45-Design ausge-
stattet werden. Die freidefinierbaren Anschlüsse können in der Menüsteuerung als Ein- oder Aus-
gänge festgelegt werden. Oberhalb der Anschlüsse wird der Betriebszustand mit LEDs angezeigt: 

 

LED Farbe Bedeutung 

Anschluss als 
DMX-In defi-
niert 

Gelb Ein: Datenempfang 

Flackern: RDM ist aktiv 

Blinkt: dauerhaft fehlerhaftes Protokoll 

Aus: keine Datenempfang 

Anschluss als 
DMX-Out de-
finiert 

Gelb Ein: Daten werden gesendet 

Flackern: Hold aktiv  – kein Empfang von Daten, letzte empfangene 
Daten werden weiter gesendet 

Blinkt: RDM aktiv 

Aus: DMX-Out ist abgeschaltet 

 

 

Taster 

Auf der Frontseite des MasterPort RM portable befinden sich ein Reset- und ein Init-Taster, mit 
denen das Gerät ohne Menüzugang zurückgesetzt und Default-Werte geladen werden können. 

 

Taste Zeit des Drückens Rückmeldung Bedeutung 

Reset < 3s keine Neustart des MasterPort RM 

> 3s keine Neustart des MasterPort RM mit Neu-
start des FPGA 

Init < 3s Kurzer Signalton Selbsttest 

> 3s Langer Signalton Laden der Default-Werte 

Nach Reset und während 
des Bootvorgangs 

Disharmoni-
scher Signalton 

Laden der Default-Firmware (Backup 
einspielen) und aller Default-Werte 

 

  



MasterPort RM 

22 

   

 

 

Stromversorgung 

Stromversorgung über PoE und Netzanschluss 

Die Spannungsversorgung der Steuereinheit des MasterPort RM portable kann wahlweise per 
Power-over-Ethernet (PoE) oder mit einem externen Netzanschluss erfolgen. In der PoE-Variante 
wird die Stromversorgung kann durch sogenannte Endspan-Devices (z. B. direkt PoE-fähige Swit-
ches) oder Midspan-Devices (Einheiten zwischen Switch und Endgerät) sichergestellt. Die Strom-
versorgung mittels Netzanschluss erfolgt über einen blauen Neutrik powerCon 230V AC Anschluss.  

 

Ist der MasterPort RM sowohl an PoE und an eine externe Spannungsversorgung 
angeschlossen, hat die Versorgung über PoE Priorität. 

 

 

Ausgang Stromversorgung 

Der LSS MasterPort RM portable besitzt einen Power-Out, der als grauer Neutrik powerCon An-
schluss ausgeführt ist. Er ist mit den 230V AC Netzanschluss parallel geschaltet. Wird der Master-
Port RM portable über PoE mit Spannung versorgt, ist der Power-Out deaktiviert. 
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Konfiguration des MasterPort RM 
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Konfiguration des MasterPort RM mit ConfigCore 

Beide Bauformen des LSS MasterPort RM werden mit Hilfe von LSS ConfigCore konfiguriert. Für 
den MasterPort RM portable steht zusätzlich ein On-Device-Menü zur Konfiguration zur Verfü-
gung. LSS ConfigCore kann als kostenlose Software auf der Homepage der LSS als heruntergeladen 
werden.  

 

 

Verbinden des MasterPort RM mit ConfigCore 

Um LSS ConfigCore mit einem MasterPort RM zu verbinden, muss der PC, auf dem ConfigCore aus-
geführt wird, in das gleiche Subnet gebracht werden, in dem sich auch das MasterPort RM befin-
det. Die Vorgehensweise zur Änderung von IP-Adressen und Subnets wird vom Anbieter des Be-
triebssystems zur Verfügung gestellt. Befinden sich der PC mit ConfigCore und der MasterPort RM 
in einem Subnet und sind miteinander über Ethernet verbunden, wird der MasterPort RM sofort 
von der Software erkannt. 

 

ConfigCore Oberfläche 

Die Oberfläche von ConfigCore besteht vor allem aus dem Geräte- und dem Einstellungsfenster. 
Mit Hilfe dieser Fenster werden alle Geräte konfiguriert.  

 

 

 

 

Gerätefenster 

 

 

 

 

Einstellungsfenster 
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Gerätefenster 

Im Gerätefenster werden alle Geräte aufgelistet, die ConfigCore gefunden hat. Geräte von LSS er-
halten vor der IP-Adresse ein „+“. Mit einem Klick auf dieses Symbol wird ein Menübaum geöffnet, 
welcher Zugang zu speziellen Einstellungsoptionen ermöglicht. 

 

Einstellungsfenster 

Im Einstellungsfenster werden alle Einstellungen des im Gerätefenster ausgewählten Gerätes an-
gezeigt. 

 

Statuspanel 

Für den LSS MasterPort RM zeigt das unter dem Gerätefenster dargestellte Statuspanel die Para-
meter Betriebszeit, Softwareversion, Anzahl gesendeter Pakete, eingestellte Sende- und Emp-
fangsprotokoll, und die CPU-Temperatur an.  

 

 

 

 

 

 

 

Statuspanel 
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ConfigCore Menüs 

Mit Klick auf das Zeichen „+“ vor dem Gerät im Gerätefenster, wird ein Menübaum mit Unterme-
nüs aufgerufen. Die Untermenüs sind rot eingefärbt. Je nach gewähltem Menü werden unter-
schiedliche Einstellungsmöglichkeiten im Einstellungsfenster angezeigt.  

 

Hauptmenü 

Im Hauptmenü dient dazu, einen Überblick über die grundlegen Eigenschaften zu geben. Ausge-
graute Eintragungen dienen der Information. Es können nur die Art-Net Kurz- und Langnamen ge-
ändert werden.  

 

 
 
 

Änderung von Art-Net Lang- und Kurznamen: 

 

1. Namen anklicken 
2. Namen ändern 
3. Mit Button „Update“ Änderung übernehmen 
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Erweiterte LSS Device Features 

Das Untermenü "Erweiterte LSS Device Features" beinhaltet die Einstellungsmöglichkeiten für 
Ethernet, RDM und die Optionen des Geräts.  

 

 
 

Um eine Einstellung/Wert zu ändern, gilt folgende Einstellungsroutine: 

 

1. Untermenü anklicken 
2. Einstellung/Wert ändern 
3. Mit Button „Update“ Änderung übernehmen 

 

 

Ethernet 

In diesem Untermenü werden die zugänglichen Netzwerkparameter eingestellt. 
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Auswahl Bedeutung 

Empfangsprotokoll Einstellung des Licht-Netzwerkprotokolls für Empfang: 

Art-Net AVAB/IPX AVAB/UDP ShowNet sACN 

Sendeprotokoll Einstellung des Licht-Netzwerkprotokolls für Senden: 

Art-Net AVAB/IPX AVAB/UDP ShowNet sACN 

Licht Timeout Einstellung des Timeouts beim Ausfall der empfangenen Daten 

0…999 s  (0 = letztes Protokoll halten) 

Netzwerk Senderate Einstellung der Mindest-Senderate für Lichtnetzwerkprotokolle, wenn sich 
keine Werte ändern.  

20ms, 25ms, 30ms, 40ms, 50ms, 0,1s, 0,2s, 0,5s, 1s, 2s, 3s, 4s 

IP Mode Bezug der IP-Adresse: 

Manuell: freie Einstellmöglichkeit 

Art-Net 2: Art-Net-Adresse im 2er Netz 

Art-Net 10: Art-Net-Adresse im 10er Netz 

DHCP:  IP-Adresse wird von einem DHCP-Server bezogen. Es muss 
  ein DHCP-Server im Netzwerk vorhanden sein! 

IP Adresse wenn Manual: freie Einstellung der IP-Adresse 

sonst:  Schaumodus für die bezogene oder generierte IP-Adresse 

Subnetmaske wenn Manual: freie Einstellung der Subnetmaske 

sonst:  Schaumodus für die bezogene oder generierte   
  Subnetmaske 

Gateway Einstellung der Gateway-Adresse 

Richtungssteuerung Nur sichtbar, wenn “Einstellung Übertragungsmedium“ manuell eingestellt. 

Full:  voller Duplex 

Half:  halber Duplex 

Netzwerk-
Geschwindigkeit 

Nur sichtbar, wenn “Einstellung Übertragungsmedium“ manuell eingestellt. 

10 Mbit/s 

100 Mbit/s 

SLP Schaltet SLP-Netzwerkprotokoll ein. 

RDM-Net Schaltet RDM-Net ein oder aus. 

Sendechecksumme On:  Berechnung der Checksumme eingeschaltet 

Off:  Berechnung der Checksumme ausgeschaltet 

Empfangscheck-
summe 

On:  Berechnung der Checksumme eingeschaltet 

Off:  Berechnung der Checksumme ausgeschaltet 

Einstellung Übertra-
gungsmedium 

Auto- 

negotiation: automatische Geschwindigkeit und Duplexmodus  

Manuell: manuell definierte Geschwindigkeit und Duplexmodus 
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Globale RDM-Einstellungen 

In diesem Untermenü können grundlegende Einstellungen für das Remote Device Management 
festgelegt werden. Diese Einstellungen gelten für alle RDM-Kanäle 

 

 
 

 

Auswahl Bedeutung 

RDM Full Time Platzhalter für RDM Einstellungen.  

RDM Quick Time Platzhalter für RDM Einstellungen. 

 

 

Optionen 

Im Punkt Optionen werden zuerst vier Informationsseiten über die Hardware, Software, Betriebs-
zähler und über das Netzwerk angezeigt. Diese können als Überwachungsmonitore eingesetzt 
werden. Darauffolgend können grundlegende Geräteeinstellungen festgelegt werden. 
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Auswahl Bedeutung 

Menü-Timeout Diese Einstellung hat nur für MasterPort RM portable Relevanz! 

Zeit bis Rückkehr vom Menü zum Grundzustand im Gerätedisplay. 

Screensaver-
Timeout 

Diese Einstellung hat nur für MasterPort RM portable Relevanz! 

Timeout für Backlight-Abschaltung des Displays  

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 6h, 
8h, 12h, 24h)  

Screensaver Events Diese Einstellung hat nur für MasterPort RM portable Relevanz! 

On: Statusänderungen an DMX-In/Out oder Ethernet schalten Bild-
 schirmschoner aus und zeigen die jeweilige Statusseite an 

Off: Statusänderungen wirken sich nicht auf Bildschirmschoner aus 

Kennwort Hauptmenü-Pin 

0…30000s (0 = aus) 

Sende sACN Draft Auswahl des unterstützen sACN-Protokolls  
On:  MasterPort RM arbeitet mit sACN nach Standard E1.31 R0 Draft 

Off:  MasterPort RM arbeitet mit sACN nach Standard E1.31 2009 

Sende Art-Net als 
Broadcast 

Erlaubt die Kommunikation mit ADB-Anlagen. 

Art-Net 3 Netzwerk Erlaubt einen ArtNet3 IP-Adressbereich 

Lüftersteuerung Der MasterPort RM 19 Zoll ist mit einem Gehäuselüfter ausgestattet, der 
entweder automatisch oder manuell gesteuert wird. 

Auto:  Automatische Steuerung 

  Ab einer Innentemperatur von 50°C wird der Gehäuselüfter 
  zur Kühlung eingeschaltet. Die Drehzahl des Lüfters steigt  
  mit der Zunahme der gemessenen Temperatur.  

 

Manuelle Steuerung 

Langsam: Geringe Drehzahl 

Mittel:  Mittlere Drehzahl 

Schneller: Erhöhte Drehzahl 

Voll:  Maximal Drehzahl 

 

Diese Auswahlmöglichkeit wird auch bei einem MasterPort RM portable 
angezeigt. Da dieses Gerät keinen Lüfter besitzt, haben diese Einstellungen 
keine Auswirkungen auf das Gerät! 
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Anschlusskonfiguration 

In diesem Menü werden die freidefinierbaren DMX-Anschlüsse eingestellt und die Parameter für 
alle DMX Aus- und Eingänge festgelegt. 

 

 
 

 

Um eine Einstellung/Wert zu ändern, gilt folgende Einstellungsroutine: 

 

1. Untermenü anklicken 
2. Einstellung/Wert ändern 
3. Mit Button „Update“ Änderung übernehmen 

 

 

Definition der DMX-Anschlüsse und Mergen von Daten 

Die DMX- Anschlüsse 1 bis 12 können einzeln und völlig frei als physikalischer Ein- oder Ausgang 
sowie als virtueller Ausgang definiert werden. Zusätzlich können sie auch abgeschaltet werden. 
Die Einstellung wird im Untermenü „Portkonfiguration“ vorgenommen. Jeder DMX-Anschluss be-
sitzt einen eigenen Mergepuffer, in dem Daten gemergt und von dort ausgesendet werden.  

 

 

Auswahl Bedeutung 

Nicht vorhanden Der DMX-Anschluss wird vollständig abgeschaltet. 

Physikalischer IN Der DMX-Anschluss ist als Eingang definiert. 

Physikalischer OUT Der DMX-Anschluss ist als Ausgang definiert. 

Virtueller Out Der physikalische Anschluss ist deaktiviert, der Mergepuffer ist aktiv. 
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DMX-Port als physikalischer IN 

Ist der DMX-Anschluss als physikalischer Eingang definiert, kann nur folgende Einstellung vorge-
nommen werden: 

 

Auswahl Bedeutung 

DMX Timeout Empfangs-Timeout bei Empfangs-Ausfall 

1…10s nach Ablauf wird DMX-Anschluss als Merge-Quelle abgeschaltet 

 

DMX-Port als physikalischer OUT 

Ist der DMX-Anschluss als physikalischer Ausgang definiert, werden im zum Anschluss gehörenden 
Mergepuffer die Daten aus verschiedenen Quellen gemergt und über den Anschluss ausgegeben. 
Folgende Einstellungen sind möglich: 

 

Auswahl Bedeutung 

DMX Timeout Timeout wenn der Mergepuffer/DMX-Out keine Daten mehr erhält. 

0:   Hold, der letzte Werte wird unverändert weiter gesendet 

1…10s:  nach Ablauf der Zeit wird Mergepuffer/DMX-Out  

  abgeschaltet 

RX Subnet Einstellung des Subnets, aus dem Daten empfangen werden (lichtprotokol-
labhängig). 

RX Universe Einstellung des Universe, aus dem Daten empfangen werden (lichtproto-
kollabhängig). 

Merge Modus Auswahl der Datenquellen, die im Puffer gemergt und über den Anschluss 
gesendet werden. 

Port 1 bis 13, Ethernetdatenquelle 0, 1 und 2 

TX Universe Einstellung des Universe, in das Daten gesendet werden (lichtprotokollab-
hängig). 

TX Priority Einstellung der Sende-Priorität (lichtprotokollabhängig) 

DMX Startcode Legt den DMX-Startcode fest. 

Sendeprotokoll-
Länge 

Legt die Länge des Sendeprotokolls fest. 

Breaklänge Einstellung der Breaklänge von 90…999 µs 

MAB Länge Einstellung der Mark-after-Break-Länge von 20…999 µs 

MBB Länge Einstellung der Mark-before-Break-Länge von 20…999 µs 

MBSL Länge Einstellung der Mark-before-Slot-Länge von 20…999 µs 

RDM Schaltet die RDM-Funktion für das ausgehende DMX-Universe ein. 

RDM Discovery Schaltet die RDM-Discovery ein oder aus.  
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DMX-Port als virtueller Ausgang 

Wird der DMX-Anschluss als virtueller Ausgang definiert, ist der physikalische Anschluss deakti-
viert. Der Mergepuffer steht hingegen als Speicher zum Mergen von Daten weiterhin zur Verfü-
gung. Gemergte Daten werden aus dem Puffer ins Ethernet ausgesandt.  

 

Auswahl Bedeutung 

DMX Timeout Timeout wenn der Mergepuffer/DMX-Out keine Daten mehr erhält. 

0:   Hold, der letzte Werte wird unverändert weiter gesendet 

1…10s:  nach Ablauf wird Mergepuffer/DMX-Out abgeschaltet 

RX Universe Einstellung des Universe, aus dem Daten empfangen werden (Anzeige 
lichtprotokollabhängig). 

RX Subnet Einstellung des Subnets, aus dem Daten empfangen werden (Anzeige 
lichtprotokollabhängig). 

RX Priority Einstellung der Priorität, aus dem Daten empfangen werden (Anzeige 
lichtprotokollabhängig). 

Merge Modus Auswahl der Datenquellen, die im Puffer gemergt und über den Anschluss 
gesendet werden. 

Port 1 bis 13, Ethernetdatenquelle 0, 1 und 2 

TX Universe Einstellung des Universe, in das Daten gesendet werden (Anzeige lichtpro-
tokollabhängig). 

TX Priority Einstellung der Priority, in das Daten gesendet werden (Anzeige lichtproto-
kollabhängig). 

TX Subnet Einstellung des Subnets, in das Daten gesendet werden (Anzeige lichtpro-
tokollabhängig). 
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Konfiguration des MasterPort RM portable am Gerät 

Wie der LSS MasterPort RM 19 Zoll kann der MasterPort RM portable mit Software LSS ConfigCore 
konfiguriert werden. Darüber hinaus bietet er für den mobilen Einsatz ein komfortables On-
Device-Menü zur Konfiguration.  

 

Menüstruktur 

Aufbau 

Die Menüstruktur des LSS MasterPort RM portable ist hierarchisch angeordnet. Die erste Ebene ist 
der Grundzustand, von dem der Zugriff auf das Hauptmenü erfolgt. Vom Hauptmenü sind die wei-
teren Untermenüs thematisch in Ebenen unterteilt. 

 

Menüauswahl 

Drehen am Encoder wählt die unterschiedlichen Menüpunkte und Schaltflächen. Das markierte 
Menü oder die Schaltfläche wird  invers  dargestellt. Kurzes Drücken auf den Encoder markiert 
diesen Menüpunkt oder die Schaltfläche als ausgewählt. 

 

Änderung von Parametern 

Der ausgewählte Parameter wird  invers blinkend  dargestellt und kann nun durch Drehen am En-
coder verändert werden. Erneutes Drücken übernimmt die Einstellung, die veränderten Parameter 
werden dann sofort wirksam. 

 

Das Betätigen der Schaltfläche „Cancel“ führt den MasterPort RM portable in das vorhergehende 
Menü zurück, geänderte Werte werden nicht gespeichert, auch wenn sie bereits temporär einge-
stellt waren. 

 

Das Betätigen der Schaltfläche „Ok“ speichert die geänderten Werte dauerhaft.  

 

Wenn der Encoder längere Zeit nicht betätigt wird, geht der MasterPort RM portable automatisch 
in den Grundzustand zurück. Dabei wird das Gerät wieder gegen unbefugte Bedienung verriegelt 
und das eingegebene Passwort gelöscht. Nicht gespeicherte Änderungen im aktuellen Menü ge-
hen verloren. Der Timeout kann im Bildschirmschoner-Menü eingestellt werden (Default 30s). 

Dieser Timeout ist in den Monitor-Modi unwirksam, damit auch längere Beobachtungen möglich 
sind. 
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Legende zur Schematische Darstellung des Menüs 

Der Aufbau des Menüs und die Konfigurationsmöglichkeiten werden im Folgenden schematisch 
dargestellt. Die verwendeten Symbole haben folgende Bedeutung: 

 

Symbol Bedeutung 

 

 

 

 

 

 

 

 

 

 

Display-Anzeige 

 

Anzeigenname 

 

 

 

Anzeigen/Parameter zur Auswahl 

 

 

 

 Auswahl durch Drehen des Encoders 

 Bestätigen durch Drücken des Encoders 

 Stellt dar, zu welcher Display-Anzeige Auswahl führt 

 

 

 

Startbildschirm 

Nach dem Einschalten des LSS MasterPort RM portable fährt innerhalb von etwa zwölf Sekunden 
das Betriebssystem hoch. Nachdem das System initiiert ist, erscheint folgender Bildschirm: 
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Grundzustand 

Systeminformation 

Nachdem der Startbildschirm angezeigt wurde, wechselt das Display in den Grundzustand. Der 
Grundzustand wird immer dann angezeigt, wenn über einen definierbaren Zeitraum keine Einga-
ben bzw. Änderungen in den Menüs vorgenommen werden. 

 

Der Grundzustand besteht aus fünf Bildschirmanzeigen, die durch Drehen des Encoders aufgeru-
fen werden. Ausgangsanzeige ist die Systeminformation: 

 

 

Software-Version 

Art-Net Shortname 

 

Ethernet-Einstellungen 

 

 

Datentransfer 

 

Softwareversion 

Diese Anzeige informiert über die aktuell genutzte Softwareversion. 

 

Art-Net Shortname 

Anzeige des Art-Net Kurznamens, mit dem der MasterPort RM portable im Netzwerk zu finden ist. 

 

Ethernet-Einstellungen 

Anzeige der IP-Einstellungen mit Art der IP-Adresse-Vergabe, aktuelle IP-Adresse mit Subnetmas-
ke, die MAC-Adresse und Seriennummer des Geräts. 

 

Datentransfer 

Anzeige, ob der MasterPort RM portable mit einem Ethernet-Netzwerk verbunden ist und ob Da-
ten gesendet oder empfangen werden. 

 

Anzeige Symbol Bedeutung 

Link Leerer Kreis Es besteht keine Verbindung zu einem Netzwerk. 

Voller Kreis Es besteht eine Verbindung zu einem Netzwerk 

Data Leerer Kreis Es werden keine Daten gesendet oder empfangen. 

Voller Kreis Es werden Daten gesendet oder empfangen.  
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DMX-Monitore 

Durch Drehen des Encoders werden zwei Monitore für die DMX- Anschlüsse und eingehende und 
ausgehende DMX-Signale aufgerufen. 

 

 

 

 

 

 

 

 

DMX-In Monitor     DMX-Out Monitor 

 

Anzeige Symbol Bedeutung 

Act Leerer Kreis Port ist als IN/OUT definiert und ungenutzt. 

Voller Kreis Port ist als IN/OUT definiert und wird genutzt. 

― Port ist nicht als IN/OUT definiert. 

Mrg Leerer Kreis Es werden keine Daten gemergt. 

Voller Kreis Es werden Daten gemergt. 

― Der Anschluss ist nicht verfügbar. 

Len 0…512 Anzeige der aktuellen Protokolllänge. 

Break In µs/ms oder s. Anzeige der Länge des Breaks. 

MAB In µs/ms oder s. Anzeige der Länge des Mark after Breaks. 

Prot In ms Anzeige der Protokolldauer und damit der Geschwindigkeit von 
DMX-Paketen.  
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Ethernet-Monitore 

Weiteres Drehen des Encoders ruft zwei Monitore für den Datentransfer ins oder aus dem Ether-
net auf.  

 

 
Monitor für eingehende Daten aus dem   Monitor für ausgehende Daten ins  

Ethernet       Ethernet 

 

Anzeige Symbol Bedeutung 

Act Leerer Kreis DMX-Port ist als IN/OUT definiert und ungenutzt. 

Voller Kreis DMX-Port ist als IN/OUT definiert und wird genutzt. 

― Port ist nicht als IN/OUT definiert. 

Mrg Leerer Kreis Es werden keine Daten gemergt. 

Voller Kreis Es werden Daten gemergt. 

― Der Anschluss ist nicht verfügbar. 

Uni 0 – 11 Anzeige des genutzten Universes (lichtprotokollabhängig). 

Sub  Anzeige des genutzten Subnets (lichtprotokollabhängig). 

Pri  Anzeige der genutzten Priorität (lichtprotokollabhängig). 

Src  Platzhalter für zukünftige Anwendungen. 
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Passworteingabe 

Vor dem Einstieg ins Hauptmenü muss ein Passwort eingegeben werden. 

 

 
 

Dabei „merkt“ sich das MasterPort RM portable das zuletzt eingegebene Passwort so lange, bis es 
entweder ausgeschaltet, rückgesetzt oder in der Passworteingabe bzw. im Password-Menü die 
Schaltfläche „Clear“ betätigt wird. 

 

 

Auswahl Bedeutung 

****** Eingabe der Buchstaben des Passwortes durch Drücken, Drehen und wieder Drü-
cken 

Clear Passwort löschen 

Ok Das Passwort wird überprüft. Bei korrekter Eingabe Aufruf des Hauptmenüs, sonst 
zurück in Grundzustand 
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Aufbau Hauptmenü 

Vom Hauptmenü aus werden alle anderen Menüs aufgerufen. Das Hauptmenü ist unterteilt in 
Monitoring-Menüs, Konfigurationsmenüs und weitere Einstellungen. 

 

 
 

Auswahl Bedeutung 

View: DMX Aufruf des DMX-Monitors. 

 Network Aufruf des Netzwerkmonitors. 

Conf.: PortSetup Aufruf des Menüs zum Definieren der DMX-Anschlüsse 

 Routing Aufruf des Menüs zur Einstellung des Routing-Verhaltens. 

 DMX Aufruf des Menüs zur Einstellung der DMX-Parameter 

 Ethernet Aufruf des Menüs zur Einstellung der Ethernet-Parameter 

Other: Options Aufruf des Menüs für Betriebseinstellungen 

OK Zurück in Grundzustand. 
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View-Menü 

Mit den Anzeigen im View-Menü erhalten Sie einen Überblick über aktuellen Einstellungen, Daten-
transfer und Mergesituation des MasterPort RM portable. Die Anzeigen sind alle in Echtzeit. Die 
Anzeigen im View-Menü verstehen sich als Monitoring. Dadurch lassen sie sich problemlos als 
Überwachungs- und Diagnosetools einsetzen. 

 

Aufbau View-Menü 
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View →DMX 

Dieser Monitor gibt einen Überblick über die Aktivitäten an den DMX- Anschlüsse. Im Untermenü 
für alle Anschlüsse können die Signale für jedes Bit hexadezimal oder prozentual dargestellt wer-
den.  

 

Alle Monitoring-Anzeigen können mit VERIFY arbeiten und sind somit ein universelles Hilfsmittel 
auch für einmalige Ereignisse („Flickerfinder“). 

 

 

View→DMX→DMX-Monitor 

Im DMX-Monitor wird auf der Übersichtsseite zunächst der Zustand der Schnittstellen angezeigt:  

 

Symbol Bedeutung 

-- Nicht als DMX-In oder Out definiert 

Leerer Kreis Als DMX-In oder Out definiert, kein Datentransfer 

Gefüllter Kreis Als DMX-In oder Out definiert, Datentransfer läuft 

 

 

View→DMX→DMX-Monitor→Port n 

Eine ausgefüllte LED bedeutet „Schnittstelle/Puffer aktiv“, leer bedeutet „nicht aktiv“. Die LEDs 
können direkt angewählt werden und mit Drücken des Encoders gelangt man so in die Monitor-
Anzeige der einzelnen Anschlüsse: 

 

 
 

Im DMX-Monitor können alle Kreise des angewählten DMX-In oder DMX-Out in ihrem Wert gra-
fisch als Balkenanzeige oder als Prozentwert und Hexadezimalzahl dargestellt werden. Die Um-
schaltung geschieht mit „Mode“.  
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In der Titelzeile werden verschiedene Messwerte angezeigt: 

 

Symbol Bedeutung 

On/Off Zustand des In oder Out 

T Senderate des Out in ms 

C Channel-Anzahl des DMX-In-Protokolls 

P (grobe) Protokolldauer des DMX-In-Protokolls 

S Startcode des DMX-In-Protokolls 

 

Unterhalb der Anzeigen können folgende Einstellungen vorgenommen werden. 

 

Einstellung Bedeutung 

Page Auswahl der Anzeigeseiten. Zur besseren Übersicht für zusammenhängende Kreise 
blättert das MasterPort RM in allen Monitoring-Anzeigen immer nur um 2 Zeilen. 

Mode Schaltet zwischen grafischer und Zahlenanzeige um. 

Verify Schaltet den Verify-Modus ein  (Anzeige [V] rechts oben im Display). 

Range Aufruf des Menüs zur Einschränkung des Verify-Bereiches. 

OK Eine Menüebene zurück. 

Hinweis: In diesem Menü ist die selbsttätige Rückkehr in den Grundzustand außer Kraft gesetzt, 
um auch längere Beobachtungen zu ermöglichen. 

 

Verify-Modus 

Mit dem Einschalten des Verify-Modus mit „Verify“ (rechts oben wird nun ein V angezeigt) wird 
exakt der aktuelle Zustand eingespeichert und im nun laufend mit den aktuellen Daten verglichen. 
Bei einer auch nur kurzzeitigen Abweichung der Daten (es genügt ein Bit) wird der Verify abgebro-
chen und das Ergebnis dargestellt (rechts oben ein nicht-inverses V). Mit einem lauten Signalton 
macht das MasterPort RM auf den Verify-Fehler aufmerksam. 

Erneutes Drücken auf „Verify“ schaltet den Verify-Modus ab (rechts oben kein V). 

Man kann damit über lange Messzeiten Protokollstörungen, -verschiebungen und Flackern durch 
defekte Geräte diagnostizieren, ohne einen speziellen DMX-Tester mit Flickerfixer zu benötigen. 
Optional ist sogar eine externe Ausgabe des Triggerimpulses z.B. für Meßgeräte möglich. 

 

Mit dem „Range“-Menü kann der Bereich für Verify bis zu einem Stromkreis eingegrenzt werden.  
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View→Ethernet 

View→Ethernet→Ethernet-Monitor 

Auf der Übersichtsseite kann der gesamte Zustand des Netzwerks überblickt werden. Eine ausge-
füllte LED bedeutet "aktiv", leer bedeutet "nicht aktiv". 

Mit „Out“ gelangt man in die Übersichtsseite der vom MasterPort RM gesendeten Universes. 

 

Untereinander sind in zwölf Zeilen die zwölf Empfangsmöglichkeiten für die zwölf Mergepuffer 

dargestellt. Subnet und Universe entsprechen den im RoutingDMX-Out eingestellten. Daneben 
verdeutlichen je drei Punkte die möglichen drei Sender, die auf dem gleichen Subnet und Universe 
empfangen und gemergt werden können.  

 

 

Die Empfangspuffer zeigen den Empfang aus den eingestellten Subnets und Universes 
auch dann an, wenn das Ethernet als Quelle im Routing ausgeschaltet ist (und somit das 
MasterPort RM selbst diese Universes nicht verwendet)! 

 

 

 

View→Ethernet→Ethernet-Monitor→In-Port n 

Eine ausgefüllte LED bedeutet „Schnittstelle/Puffer aktiv“, leer bedeutet „nicht aktiv“. Die LEDs 
können direkt angewählt werden und mit Drücken des Encoders gelangt man so in die Monitor-
Anzeige, die in Bedienung und Darstellung exakt der des DMX-Monitors entspricht (siehe 
View→DMX→DMX-Monitor→Port n View →DMX). 

 

 
 

Der einzige Unterschied besteht darin, dass in der obersten Zeile die IP- bzw. (bei AVAB/IPX-
Protokoll) die MAC-Adresse des Senders zu sehen ist, der auf diesem Socket sendet. Somit kann 
festgestellt werden, welche Anlagen auf dem gleichen Subnet/Universe mit welchen Werten zur 
Summe beitragen. 

Werden Daten weder empfangen noch gesendet, steht über der Monitorseite „Socket not used“. 

  



MasterPort RM 

 
LSS 45 

 

 

 

In der Titelzeile werden angezeigt: 

 

Symbol Bedeutung 

In/Out In oder Out 

1/1 Merge-Puffernummer (1…12) / Merge-Teilnehmer (1…3) 

Adresse bei In:   IP/MAC-Adresse des Senders;  

bei Out:  die eigene IP/MAC des MasterPort RM 

Zahl Paketzähler 

 

 

View→Ethernet→Ethernet-Monitor→Out 

Untereinander sind in zwölf Zeilen die zwölf aussendbaren Mergepuffer des MasterPort RM dar-

gestellt. Subnet und Universe entsprechen den im RoutingEthernet Out eingestellten. 

Auch hier kann die LED direkt angewählt werden. Das Monitoring ist genau wie bei In möglich. 
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Config-Menü 

Im Config-Menü können Sie die vielfältigen Einstellungsmöglichkeiten des MasterPort RM portable 
komfortabel ändern. Zu Ihrer eigenen Sicherheit müssen Sie vor jeder Änderung der Einstellungen 
diese Änderung auch bestätigen.  

 

Bitte beachten Sie, dass jede Änderung der Einstellungen weitreichende Folgen auf Ihre 
Lichtanlage haben kann. Die folgend beschriebenen Einstellungsmöglichkeiten setzen 
auch voraus, dass Sie Erfahrungen und Kenntnisse in der DMX- Konfiguration besitzen.  

 

 

 

Aufbau des Config-Menüs 

 

 

 
 

Menü Einstellungsmöglichkeiten 

PortSetup Einstellung der DMX-Anschlussdefinition 

Routing Einstellung des Konvertieren und Mergen nach Ethernet und DMX 

DMX Einstellung der DMX-Anschlüsse  

Ethernet Einstellung der Netzwerkprotokolle 
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Configuration→PortSetup 

Im Menü PortSetup werden die DMX-Anschlüsse als Ein- oder Ausgänge definiert. Sie können auch 
abgeschaltet werden, die Definition als virtueller Ausgang bleibt aber der Konfiguration mit Con-
figCore vorbehalten.  
 

 
 
 

Symbol Bedeutung 

N/A DMX-Anschluss ist abgeschaltet 

DMX-In DMX-Anschluss ist als DMX-Eingang definiert 

DMX-Out DMX-Anschluss ist als DMX-Ausgang definier 

 
 

Der DMX-Anschluss 13 ist wie immer der festinstallierte und festdefinierte DMX-In. Eine 
Änderung der Einstellung auf DMX-Out führt zu einem Abschalten des Anschlusses. 
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Configuration→Routing 

Im Menü Routing werden die Einstellungen für das Konvertieren und Mergen von Daten zu Ether-
net und DMX vorgenommen. Zum Mergen stehen insgesamt zwölf Mergepuffer zur Verfügung. 
Diese sind den DMX-Outs zugeordnet, können aber von Software auch ins Ethernet geroutet wer-
den.  

 

 

 
 

Auswahl Bedeutung 

Network Out Einstellung zum Konvertieren und Mergen von Daten ins Ethernet 

DMX-Out 1...12 Einstellung zum Konvertieren und Mergen von Daten nach DMX 

OK Eine Menüebene zurück. 
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Configuration → Routing → Ethernet Out  

In diesem Menü wird bestimmt, was der MasterPort RM portable ins Ethernet aussenden soll.  

Die Auswahl Out 1 bis Out 12 entspricht der Auswahl der Mergepuffer 1 bis 12. Hier wird also nur 
der gewünschte Mergepuffer dem Ethernet zugeordnet. Der Inhalt des Mergepuffers wird erst im 
folgenden Menü Routing→DMX-Out definiert. 

 

Auch beim Konvertieren von Ethernet-Protokoll zu Ethernet-Protokoll muss der 
Weg über die Mergepuffer gewählt werden! 

 

Auswahl Bedeutung 

Protocol Informiert über das derzeit aktuelle Sendeprotokoll. Die Auswahl des Sendeproto-
kolls erfolgt im Menü Config→Ethernet. 

Out <n> Off: Es werden keine Lichtdaten über Ethernet ausgesendet 

On: Wenn der Mergepuffer <n> aktiv ist und von mindestens einer Quelle  
 Daten empfängt, sendet der MasterPort RM portable diese Lichtdaten über 
 Ethernet mit dem hier eingestellten Subnetz und Universe aus. 

Subnet Einstellung des Ethernet-Subnetzes (abhängig vom Lichtprotokoll) 

Universe Einstellung des Ethernet-Universes (abhängig vom Lichtprotokoll) 

Priority Einstellung der Sende-Priorität (lichtprotokollabhängig) 

OK Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 

 

 

 

Configuration → Routing → DMX-Out 

In diesem Menü wird der Inhalt der Mergepuffer definiert. Der Mergepuffer ist aktiv, wenn min-
destens eine der eingestellten Quellen aktiv ist. Bei mehreren eingeschalteten Quellen werden alle 
nach dem HTP-Prinzip zusammengefasst. Wenn alle Quellen auf OFF stehen, ist der Mergepuffer 
abgeschaltet. Fällt die letzte aktive Quelle aus, wird nach Verstreichen des im DMX-Config-Menü 
eingegebenen Out-Timeouts der Mergepuffer abgeschaltet bzw. bei „HOLD“ der letzte Wert ge-
halten. 

 

Aus technischen Gründen entspricht der Mergepuffer dem entsprechenden DMX-Out 
Port. Also Mergepuffer 1 entspricht Port DMX-Out1 usw. 

 

Beim Konvertieren von Ethernet-Protokoll zu Ethernet-Protokoll muss ein Mergepuffer 
belegt werden. Der zugehörige DMX-Out Port ist dann belegt! 
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Auswahl Bedeutung 

DMX-In 1…90123:  Anzeige der DMX-Anschlüsse. 0123 verstehen sich als 10er Werte, also 
10, 11, 12 und 13.  

-: DMX-Anschluss ist nicht als DMX-In definiert. 

Leerer Kreis: DMX-Anschluss ist als DMX-In definiert. Er ist nicht als Datenquelle aus-
gewählt. 

Voller Kreis: DMX-Anschluss ist als DMX-In definiert und als Datenquelle ausge-
wählt. 

Ethernet OFF:  Es werden keine Ethernet-Daten berücksichtigt 

Single:  Es werden nur die vom ersten Sender empfangenen Lichtdaten hinzu-
gemergt. Sollten gleichzeitig von mehreren Sendern Telegramme mit 
dem eingestellten Subnetz und Universe anliegen, wird nur der erste 
erkannte Sender berücksichtigt. Die Sender-Erkennung erfolgt bei sACN 
durch die CID, bei AVAB/IPX durch die MAC-Adresse und bei allen ande-
ren Protokollen durch die IP-Adresse des Senders, die für jeden Sender 
individuell sein muss. Bei Ausbleiben des Signals wird nach der Time-
out-Zeit ggf. ein anderer Sender ermittelt (Prinzip: „Der Erste darf“). 

Merge 3:  Es werden die Daten von bis zu 3 Ethernet-Sendern nach dem HTP-
Prinzip zusammengefasst. Sollten gleichzeitig von mehr als 3 Sendern 
Telegramme mit dem Subnetz und Universe dieses Ausgangs anliegen, 
werden nur die ersten 3 erkannten Sender berücksichtigt. Bei Ausblei-
ben eines Signals wird nach der Timeout-Zeit ggf. ein anderer Sender 
ermittelt (Prinzip: „Wer zuerst kommt“).  

Subnet Auswahl des Subnets, aus dem Daten zum mergen entnommen werden. 

Nur angezeigt, wenn Ethernet auf „Single“ oder „Merge 3“ steht. 

Einstellung des Ethernet-Subnetzes (Abhängig vom Lichtprotokoll) 

Universe Auswahl des Universe, aus dem Daten zum mergen entnommen werden. 

Nur angezeigt, wenn Ethernet auf „Single“ oder „Merge 3“ steht. 

Einstellung des Ethernet-Universes (Abhängig vom Lichtprotokoll) 

OK Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 
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Configuration → DMX  

In diesem Menü werden die technischen Einstellungen für die DMX-Anschlüsse vorgenommen. Die 
Einstellungen können separat für jeden Anschluss vorgenommen werden.  

 

Die Anzeige „result/fps“ gibt die durchschnittliche Dauer eines DMX-Frames an. Sie wird errechnet 
aus Protocol length, Break, MAB, MBS und MBB. Beim Wert = 44 wird das DMX-Signal mit maxima-
ler Geschwindigkeit gesendet.  

 

Durch Ändern der Default-Werte können hier Werte erzeugt werden, die für die Stabili-
tät des Netzwerkes und der Lichtsteuerung gefährliche Auswirkungen haben können! 
Die Default-Einstellungen sollten aus diesem Grund nicht geändert werden! 
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Die folgenden Einstellungen werden einzeln pro Port festgelegt: 

 

Einstellung Bedeutung 

DMX-Ports Auswahl des DMX- Anschlüsse. Ob der Anschluss als eingehendes (In) oder aus-
gehendes (Out) Universum definiert ist, wird hinter der Port-Nummer ange-
zeigt. 

TimeOut Port = In: Empfangs-Timeout bei Empfangs-Ausfall. Nach Ablauf der einge-
  stellten Zeit, wird der DMX-In als Merge-Quelle abgeschaltet. 

Port = Out: Sende-Timeout wenn der Mergepuffer/DMX-Out keine Daten 
  mehr erhält 

 Hold: Der letzte Wert wird unverändert weiter gesendet. 

 1…10: Nach Ablauf der eingestellten Zeit wird der Mergepuffer/DMX-
  Out abgeschaltet. 

Protocol 
length 

0…512: Anzahl der Universes/Informationen pro Frame 

(nur wenn der Port als Out definiert ist) 

Break Stellt die Länge des Breaks für das gewählte Universum ein. 

(nur wenn der Port als Out definiert ist) 

MAB Stellt die Länge des Marks nach dem Break für das gewählte Universum ein. 

(nur wenn der Port als Out definiert ist) 

Mark 
between slots 

Stellt die Länge des Marks zwischen den Universes/Informationen innerhalb 
des Frames für das gewählte Universum ein. 

(nur wenn der Port als Out definiert ist) 

Mark before 
break 

Stellt die Länge des Marks vor dem Break für das gewählte Universum ein. 

(nur wenn der Port als Out definiert ist) 

RDM On: Schaltet das RDM für den gewählten Anschluss ein. 

Off: Schaltet das RDM für den gewählten Anschluss aus. 

Der MasterPort RM tritt an definierten Out-Anschlüssen als RDM-Controller 
und an definierten In-Anschlüssen als Responder auf. 

Discovery 

(nur sichtbar, 
wenn RDM 
aktiv und 
mindestens 
ein Anschluss 
als Out defi-
niert ist) 

Der MasterPort RM unterstützt verschiedene RDM-Discovery Modi. 

On: Aktiviert die RDM-Discovery Funktion für den ausgewählten Anschluss. 

Off: Deaktiviert die RDM-Discovery Funktion für den ausgewählten  
 Anschluss. 

 

Eine neu angestoßene volle RDM-Discovery verursacht kurzzeitig hohen 
Datentraffic im Universe und kann die DMX-Steuerung beeinträchtigen! 

Ok Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 
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Configuration → DMX → RDM 

In diesem Untermenü werden die globalen, für alle Universen geltenden RDM-Einstellungen fest-
gelegt. 

Einstellung Bedeutung 

RDM-Intervall Stellt die Intervallzeiten der der inkrementellen Discovery in Sekunden ein. 

Incremental 
discovery 

Mit dieser Funktion ist RDM-Discovery immer aktiv! Es werden immer Daten 
gesammelt und Identifizierungsanfragen für neue Geräte in die Universen ge-
sendet.  

On: Incremental discovery ist immer aktiv. 

Off: Incremental discovery ist nicht aktiv. 

Background 
discovery 

Mit dieser Funktion arbeitet die inkrementelle Discovery im Hintergrund. 
Dadurch wird das DMX-Signal weniger gestört. Allerdings kann es sein, dass sich 
die Intervallzeit weit über oben eingestellte hinaus verlängert! 

On: Background discovery ist aktiv. 

Off: Background discovery ist nicht aktiv. 

Ok Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 

 

 

RDM-Discovery verursacht sehr hohen Datentraffic in den Universen! Es kann die DMX-
Steuerung beeinträchtigen oder sogar unmöglich machen! 
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Configuration → Ethernet 

In diesem Menü erfolgt die Anzeige und Einstellung der Netzwerkparameter: 
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Die Mac-Adresse und die Seriennummer sind reine Anzeigen und können nicht verändert werden.  

 

Einstellungen Bedeutung 

Receive 

Protocol 

Einstellung des Empfangs-Netzwerkprotokolls 

Receive time-
out 

Einstellung des Timeouts beim Datenempfang 

0 = letztes Protokoll halten 

Transmit Pro-
tocol 

Einstellung des Sende-Netzwerkprotokolls  

Default:  Sendeprotokoll entspricht dem Empfangsprotokoll  

Max. frame 
distance 

Einstellung der Mindestsenderate wenn sich keine Werte ändern. 

IP Bezug der IP-Adresse:  
IP address:  freie Einstellmöglichkeit  
Art-Net 2: Art-Net-Adresse im 2er Netz  
Art-Net 10:  Art-Net-Adresse im 10er Netz  

DHCP:   wenn DHCP-Server im Netzwerk vorhanden  

Subnet mask Netzwerkmaske: die manuelle Einstellung ist nur bei „IP address“ möglich 

Gateway Gateway:  die manuelle Einstellung ist nur bei „IP address“ möglich 

Options Aufruf der Seite zur Einstellung der Nebenanlage 

Ok Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 

 

 Der Timeout für DHCP nach dem Neustart des MasterPort RM portable ist stan-
dardmäßig 10s, danach erfolgt ein Fallback auf eine nach RFC3927  automatisch 
erzeugte IP-Adresse ("Zeroconf", 169.254.x.x). 
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Configuration → Ethernet→Options 
In diesem Menü werden optionale Einstellungen vorgenommen. 
 

Einstellung Bedeutung 

SLPv2 (RFC2608) 
protocol 

Das SLP ist ein Netzwerkprotokoll für Netzwerkdienste.  
On:  Aktiviert das SLPv2 Netzwerkprotokoll. 
Off:  Deaktiviert das SLPv2 Netzwerkprotokoll. 

RDM-Net (E1.33) 
protocol 

RDM-Net ist ein Protokoll zum Austausch von RDM-Meldungen über 
Ethernet. 
On:  Aktiviert das RDM-Net Netzwerkprotokoll  
  nach Standard E1.33. 
Off:  Deaktiviert das RDM-Net Netzwerkprotokoll  
  nach Standard E1.33. 

Transmit sACN 
(E1.31) Draft 

Auswahl des gesendeten sACN-Protokolls  
On:  Der MasterPort RM portable arbeitet mit sACN-Draft. 

Off:  Der MasterPort RM portable arbeitet mit sACN-Release. 

Art-Net send full 
broadcast 

Off:  Der MasterPort RM portable sendet im Art-Net-Standard  
  2.xxx.xxx.xxx. 

On:  Der MasterPort RM portable sendet erweiterten IP-Bereich 
  255.xxx.xxx.xxx. 

Art-Net III network 
address 

0:  Art-Net II kompatibel 

1…127: Art-Net III Netzwerkadresse 

UDP-Checksum Einstellung zur Berechnung der Prüfsummen von UDP-Datenpaketen  
Rx & Tx: Prüfsummen für empfangene und gesendete Pakete  
Rx only: Prüfsummen nur für empfangene Pakete  
Tx only: Prüfsummen nur für gesendete Pakete  

Off:  Prüfsummenberechnung aus  

Ethernet media  Einstellung der Übertragungsgeschwindigkeit  
Autoneg.: Automatische Ermittlung der Übertragungsgeschwindigkeit  
10 Half: 10MBit/s Half Duplex  
10 Full: 10MBit/s Full Duplex  
100 Half: 100MBit/s Half Duplex  

100 Full: 100MBit/s Full Duplex  

Cancel Abbruch und eine Menüebene zurück. 

Ok Einstellungen speichern und eine Menüebene zurück. 
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Options 

Im Menü Options werden die Zusatzfunktionen des LSS MasterPort RM portable eingestellt und In-
formationen über Hard- und Software angezeigt. 

 

Aufbau des Menüs Options 

 

 
 

 

Auswahl Bedeutung 

CPU info Anzeige von CPU-Informationen. 

Component info Anzeige der internen Komponenten. 

Software info Anzeige von Software-Informationen. 

Display Options Menüs zur Einstellung des Displays.  

Security Menüs zum Einstellen / Abschalten des Passworts. 

Restore settings Menüs zum Rücksetzen des MasterPort RM portable 

Watchdog reset Rücksetzen des MasterPort RM portable und Test des Watchdog. 

Ok Eine Menüebene zurück. 
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Options → CPU Info  

Hier werden Informationen zur Rechner-Zentraleinheit (CPU), die Versionen von Hauptplatine und 
BIOS sowie die Größe des Flash-Speichers, der als Harddisk dient, angezeigt: 

 

Auswahl Bedeutung 

Counter Aufruf des Menüs zur Anzeige der Boot- und Fehlerzähler. 

OK Eine Menüebene zurück. 

 

Options → CPU Info → Counter  

Hier werden die internen Betriebsspannungen, Temperaturen sowie verschiedene Zählerstände 
angezeigt. Die Zähler können auf 0 gesetzt werden, um Ereignisse ab einem bestimmten Zeitpunkt 
zu zählen: 

 

Wert Bedeutung 

Date/Time Anzeige der aktuellen Systemzeit 

+5V Betriebsspannung des MasterPort RM portable 

Bat Spannung der internen Pufferbatterie  

Ist die Spannung unter 2,5V, ersetzen Sie die Batterie! 

CPU Temperatur der CPU 

Brd Temperatur des Mainboards 

Running time Betriebsstundenzähler; kann angewählt und auf 0 gesetzt werden. 

Power on starts Bootvorgänge; kann angewählt und auf 0 gesetzt werden. 

Init Setzt alle Zähler auf die intern im EEPROM mitgezählten Originalwerte. 

Ok Eine Menüebene zurück. 

 

Options → Component Info  

Zeigt Informationen zu den Firmware-Versionen der internen Komponenten an.  

 

Options → Software Info 

Hier werden Informationen zur Firmware-Version, Betriebssystem sowie Programmgröße und 
freiem Speicher angezeigt. Außerdem werden die über Art-Net programmierbaren langen und 
kurzen Gerätenamen angezeigt. 
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Options → Display Options  

In diesem Menü können Sie verschiedene Zeitabläufe einstellen: 

 

 
 

Einstellung Bedeutung 

Menu timeout 
(w/o monitors) 

Timeout für Verlassen des Menüs bei Nichteingabe und Rückkehr zum Grund-
zustand. 

Gilt nicht für die Monitoring-Seiten. 

Screensaver 
timeout 

Timeout für Backlight-Abschaltung des Displays 

Außer für Vorführungen, Messen usw. sollte diese immer aktiviert werden, 
um das LED-Backlight des Displays zu schonen. 

Screensaver 
events 

Off: Statusänderungen wirken sich nicht auf Bildschirmschoner aus 

On: Statusänderungen an DMX-In/Out oder Ethernet schalten Bild
 schirmschoner aus und zeigen die jeweilige Statusseite an 

Remote pro-
gramming 

On: MasterPort RM portable ist per Art-Net programmierbar 

Off: MasterPort RM portable ist nicht per Art-Net programmierbar 

Art-Net ist die Grundlage für ConfigCore. Ist diese Funktion deaktiviert, kann 
das Gerät nicht über die Konfigurationssoftware eingestellt werden. 

Fan Control Diese Einstellungen haben für den MasterPort RM portable keine Bedeutung. 

Ok Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 
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Options → Security 

Hier können Sie das Passwort ändert oder die Passwortabfrage abschalten: 

 

Das aktuelle Passwort wird immer als „******“ angezeigt, auch wenn es kürzer als 6 Zeichen ist. 
Durch Drücken auf „Clear“ wird das Passwort gelöscht (Anzeige „______“). Wenn dieser Zustand 
mit „Ok“ gespeichert wird, erfolgen keine Passwortabfragen mehr. 

 

Durch Anwahl einer Stelle und Drücken sowie Drehen des Encoders können Buchstaben eingege-
ben und durch erneutes Drücken übernommen werden. Es gibt nur Kleinbuchstaben, „_“ ent-
spricht einem Leerzeichen. „Ok“ speichert dann das neue Passwort ab. 

 

Auswahl Bedeutung 

****** Passworteingabe 

Clear Passwort löschen. 

Ok Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 

 

 

Obwohl das System eine große Sicherheit bietet, kann eine absolute Sicherheit nicht 
gewährleistet werden! Treffen Sie geeignete Maßnahmen vor Ort, um einen nichtauto-
risierten Zugriff zu verhindern! 
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Options → Restore Settings  

Im MasterPort RM portable können Wiederherstellungspunkte definiert werden. Dadurch können 
neben den Werkseinstellungen auch eigene Einstellungen gespeichert und zu einem späteren 
Zeitpunkt wieder geladen werden. Es können dabei bis zu 100 eigene Einstellungen gespeichert 
und frei wählbar geladen werden. 

 

Beachten Sie die angezeigten Warnungen! 

 

 
 

Einstellung Bedeutung 

Restore to Auswahl der Factory defaults (Werkseinstellungen gemäß letzten Firmware-
Updates) oder einen Wiederherstellungspunktes nach Datum und Zeit 

User saved Anzahl der gespeicherten Wiederherstellungspunkte 

Delete Löscht gespeicherte Wiederherstellungspunkte (diese müssen unter Restore to 
aufgerufen sein) 

Save Speichert Wiederherstellungspunkte mit Datum und Zeit 

OK Führt das Laden der Factory defaults bzw. des Wiederherstellungszeitpunktes 
aus. 

Cancel Rückkehr auf übergeordnetes Menü 

 

 

Options → Watchdog reset 

Unter diesem Menüpunkt wird das Gerät hardwaremäßig rückgesetzt und damit der Watchdog 
getestet. 
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Netzsicherung wechseln 

Sicherungstyp:  Feinsicherung Glasrohr 2AT, Id.-Nr. 03105 

 

1. Trennen Sie das Gerät von der Spannungsversorgung und jeglichen anderen Verbindungen. 

2. Entriegeln Sie den Sicherungshalter oberhalb der Kaltgerätebuchse. 

3. Entnehmen Sie den Sicherungshalter. 

4. Entnehmen Sie die defekte Sicherung. 

5. Ersetzen Sie diese durch eine intakte Sicherung. 

6. Schieben Sie den Sicherungshalter wieder ein und vergewissern Sie sich, dass der Halter 
einrastet. 

 

Überbrücken Sie niemals eine Sicherung! 

Verwenden Sie nur den oben angegebenen Sicherungstyp! 

Stellen Sie sicher, dass der Sicherungshalter fest eingerastet ist! 

 

Kontaktaufnahme 

Falls Probleme beim Betrieb des LSS MasterPort RM auftreten, sollten die Beschreibungen und 
Hinweise in diesem Handbuch zur Fehleranalyse und Fehlerbehebung weiterhelfen. Sollte dies 
nicht der Fall und es werden weiterführende Hilfestellungen benötigt, wenden Sie sich an den LSS 
Service. 

 

Bei der Kontaktaufnahme sollten folgende Informationen vorliegen: 

 

- Ort der Gesamtanlage und Position des MasterPort RM in der Anlage (mit Angabe von Se-
riennummer/MAC-Adresse/IP-Adresse) 

- Ausführliche Fehlerbeschreibung 
- Ausführliche Beschreibung der bisher erfolgten Fehlersuche 
- Beschreibung zusammenhängender System- oder Geräteprobleme 

 

Kontaktadresse: 

LSS GmbH 

Licht-, Steuer- und Schaltanlagenbau GmbH 

Am Eichenberg 1 

D-04600 Altenburg 

Tel.: +49 3447 83 55 00 

Fax: +49 3447 86 17 79 

mail@lss-lighting.de  
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Anhang A 

Besonderheiten der Netzwerkprotokolle 

Die Netzwerkeinstellungen (IP-Mode, IP-Adresse, Netzwerkmaske) des MasterPort RM  wirken sich 
bei den verschiedenen Lichtprotokollen unterschiedlich aus: 

 

Licht-
Protokoll 

IP-Besonderheiten 

Art-Net IP-Mode, IP-Adresse und Netzmaske wirken sich direkt auf Art-Net aus. Aus Kompa-
tibilitätsgründen sollte immer der automatische IP-Mode „Art-Net2“ verwendet 
werden. 

AVAB/IPX IP-Mode, IP-Adresse und Netzmaske wirken sich überhaupt nicht auf AVAB/IPX aus, 
da dieses ein Novell-Protokoll ist. 

Der MasterPort RM kann aber trotzdem remote über Art-Net konfiguriert werden, 
dafür sind IP-Mode, IP-Adresse und Netzmaske relevant  -zur Kompatibilität auch 
hier am besten „Art-Net2“ verwenden. 

AVAB/UDP IP-Mode, IP-Adresse und Netzmaske wirken nicht auf AVAB/UDP aus, da AVAB/UDP 
mit  Broadcasts arbeitet. 

So kann man auch hier am besten die Defaulteinstellung „Art-Net2“ verwenden und 
damit auch hier immer den MasterPort RM über Art-Net remote konfigurieren. 

ShowNet IP-Mode, IP-Adresse und Netzmaske wirken sich auf ShowNet aus.  

Häufig wird 192.168.0.x oder 192.168.1.x verwendet. Die Netzwerkmaske sollte 
255.255.255.0 sein.  

Um dies einstellen zu können, muss der IP-Mode „Manuell“ sein (oder DHCP, falls es 
einen entsprechenden DHCP-Server im Netz gibt). 

Der MasterPort RM kann trotzdem remote mittels ConfigCore über Art-Net konfigu-
riert werden. 

sACN IP-Mode, IP-Adresse und Netzmaske wirken sich nicht auf ACN aus, da ACN ein Mul-
ticast-Protokoll mit der IP 239.255.x.y ist. Dieses wird unabhängig empfangen. 

So kann man auch hier am besten die Defaulteinstellung „Art-Net2“ verwenden und 
damit auch hier immer den MasterPort RM über Art-Net remote konfigurieren. 
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Die einstellbaren Parameter Subnet und Universe unterscheiden sich wie folgt: 

 

Protokoll Universe Subnet Besonderheiten 

Art-Net 0…15 0…15 Der MasterPort RM kann auf jedem einzelnen DMX-Port mit 
verschiedenem Subnet und Universe arbeiten. 

Dies ist mit ConfigCore, nicht aber mit Fremdsoftware, einzeln 
einstellbar, nur mit dem LSS-Softwaretool. 

AVAB/IPX 1…12 0…9 Beim Senden ist die Priorität von 0...200 einstellbar. 

AVAB/UDP 1…32 0…9 Beim Senden ist die Priorität von 0...200 einstellbar. 

ShowNet 1…36 nicht 
vorhan-
den 

Bei ShowNet gibt es eigentlich keine Universes,  alle Dimmer-
daten werden in einem 18432 Kreise großen Feld dargestellt. 
In älteren Anlagen (5xx) konnte man dies auch konfigurieren. 

Trotzdem hat sich in der Praxis die Einteilung in Vielfache von 
512 durchgesetzt (wegen DMX). 

Der MasterPort RM verhält sich beim Einstellen des Universe 
wie neuere Anlagen von Strand Lighting: hier stellt man nur 
noch Vielfache von 512 ein, „XDMX Nr.“ genannt. „Krumme“ 
Adressen sind nicht möglich. Die realen Kreisnummern von 
1…18432 werden im Routing zusätzlich angezeigt.  

sACN 1… 65279 nicht 
vorhan-
den 

Beim Senden ist die Priorität von 0...200 einstellbar. 

 

Wahl des Lichtprotokolls 

Bietet eine Anlage mehrere Lichtprotokolle zur Auswahl, so sollte vom Standpunkt der Netzwerk-
belastung die Rangfolge sein: 

1. sACN 

2. Art-Net 

3. ShowNet 

4. AVAB/UDP 

5. AVAB/IPX 
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Konfiguration für die verschiedenen Lichtprotokolle 

sACN 

Das Licht-Netzwerkprotokoll sACN ist das werksseitig voreingestellte Standardprotokoll. Beim La-
den der Default-Werte wird dieses Licht-Netzwerkprotokoll aktiviert und folgende Parameter ein-
gestellt:  

 

Empfangs-Netzwerkprotokoll: sACN 

Empfangstimeout:   3s 

Sende-Netzwerkprotokoll:  sACN 

Senderate:    0,5s 

 

Da der MasterPort RM in den Default-Einstellungen als DMX-Booster läuft, sind folgende Routing-
Parameter voreingestellt: 

 

DMX-Anschlüsse 1 bis 12:  Out 

Sendepriorität:   0 (entspricht 100) 

DMX-Anschluss 13:   In 

Ethernet als Mergequelle:  deaktiviert 

 

Wird der MasterPort RM mit dem Netzwerkprotokoll sACN eingesetzt, so kann die Netzwerkbelas-
tung für ihn und andere Netzwerkteilnehmer sehr effektiv gesenkt werden, wenn man manage-
mentbare Switche einsetzt, die das sogenannte "IGMP Snooping" beherrschen. 

 

Derartige Switche erkennen, welche Universes die Geräte an jedem Switch-Port benötigen und 
schalten dann nur diese Universes zu den jeweiligen Geräten durch. 

 

Per Default hört der MasterPort RM auch auf Art-Net-Softwaretools und andere Anlagen. 

 

Art-Net 

Schalten Sie das Empfang-Netzwerkprotokolls AVAB/IPX ein. Der Empfangstimeout ist 8s, die Sen-
derate ist 1s. 

Das Default-Subnet ist 0 und die Universes 0…12 für die zwölf DMX-Anschlüsse (egal ob diese In 
oder Out sind). Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…12 
ein. Dort schalten Sie die Ports auch einzeln ein oder aus. 

 

Per Default hört der MasterPort RM auch auf Art-Net-Softwaretools und andere Anlagen. 
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ShowNet 

Schalten Sie das Empfangs-Netzwerkprotokoll ShowNet ein. Empfangstimeout ist 8s. 

 

Schalten Sie das Sende-Netzwerkprotokoll ShowNet ein. Stellen Sie die Senderate auf 4s. 

 

Die Default-Universes (XDMX) sind 1…12 für die zwölf DMX-Anschlüsse (egal ob diese In oder Out 
sind). 

Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…12 ein. Dort schal-
ten Sie die Ports auch einzeln ein oder aus. 

Per Default hört der MasterPort RM zwar auf Art-Net-Softwaretools, aber nicht jedes kommt mit 
den 192.168er IP-Adressbereichen klar. 

 

AVAB/IPX 

Schalten Sie das Empfang-Netzwerkprotokolls AVAB/IPX ein. Stellen Sie den Empfangstimeout auf 
3s. 

 

Schalten Sie das Sende-Netzwerkprotokolls AVAB/IPX ein. Stellen Sie die Senderate auf 0,5s. 

 

Das Default-Subnet ist 0 und die Universes 1…12 für die zwölf DMX-Anschlüsse (egal ob diese In 
oder Out sind). Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…12 
ein. Dort schalten Sie die Ports auch einzeln ein oder aus. 

Per Default hört der MasterPort RM auch auf Art-Net-Softwaretools und andere Anlagen. 

 

AVAB/UDP 

Schalten Sie das Empfang-Netzwerkprotokolls AVAB/UDP ein. Stellen Sie den Empfangstimeout 
auf 3s. 

 

Schalten Sie das Sende-Netzwerkprotokolls AVAB/UDP ein. Stellen Sie die Senderate auf 0,5s. 

 

Das Default-Subnet ist 0 und die Universes 1…12 für die zwölf DMX-Anschlüsse (egal ob diese In 
oder Out sind). Die Default-Sendepriorität ist 0 (entspricht höchster, immer mergen). Andere Sub-
nets und/oder Universes stellen Sie unter Config→Routing→Port1…12 ein. Dort schalten Sie die 
Ports auch einzeln ein oder aus. 

 

Per Default hört der MasterPort RM auch auf Art-Net-Softwaretools und andere Anlagen. 
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Anhang B 

Begriffe 

ACN „Architecture for Control Networks“ ANSI E1.17 

Von einem internationalen Gremium unter Führung der ESTA standardisierte 
Netzwerkprotokoll-Suite für Geräte im Entertainment Bereich. Beinhaltet sehr 
umfangreiche Mechanismen und Vorgaben für die in den Geräten verwendeten 
Netzwerkprotokolle, Erkennungsmechanismen, Konfigurationsmöglichkeiten mit-
tels XML-Files, Datenübertragungen usw. 

Bisher werden von vielen Herstellern aus Aufwandsgründen (der Standard enthält 
über 400 Seiten) nur Untermengen von ACN implementiert, z.B. die Streaming-
Daten für Licht-Universes (sACN ANSI E1.31). 

Broadcast In der Netzwerktechnik Protokolle, die an ganze Subnetze (Subnetz-Broadcast) 
oder „an alle“ Netzwerkteilnehmer gesendet werden. Broadcasts sind sehr ineffi-
zient, weil das Netzwerk und alle Teilnehmer belastet werden und sollten daher 
wenn möglich durch Multicast ersetzt werden.  

Broadcasts werden nicht geroutet. 

Broadcasts „an alle“ verwenden in der Lichttechnik z.B. AVAB/IPX und AVAB/UDP. 

Art-Net verwendet zum Teil Subnetz-Broadcasts, was de facto auch einem 
Broadcast für alle Art-Net-Geräte gleichkommt. 

DMX DMX512 

1990 von der USITT vorgeschlagenes Bussystem für Licht- und Medientechnik. 
Später als DIN 56930-2 und ANSI Standard E1.11 festgelegt. 

HTP Highest Takes Precedence 

Übliche Form des Mergens von DMX-Daten: der höchste Wert mehrerer Eingänge 
bestimmt den Ausgabewert. 

IGMP Internet Group Managment Protocol. 

Wird u.a. im Zusammenhang mit Multicast und zur intelligenten Verteilung der 
Netzlast verwendet. Multicast-Teilnehmer melden sich damit z.B. im Netzwerk an 
und ab, um intelligenten Switches mitzuteilen, dass Protokolle ihres Adressbe-
reichs an bestimmten Ports ausgegeben werden sollen. 

Der MasterPort RM unterstützt IGMP v.2. 

IP Internet Protocol. Computernetzwerkprotokoll, Grundlage des Internet. Erste, 
vom Übertragungsmedium unabhängige Protokollschicht. Ermöglicht eine Adres-
sierung von Netzwerkteilnehmern und Gruppen mittels IP-Adresse und Subnetz-
maske, ist damit auch routingfähig. 

IP-Adresse Netzwerknummer eines Teilnehmers in einem IP-Netz. 32-stellige Binärzahl, wird 
meist als 4-stellige Dezimalzahl im Bereich von 0…255 geschrieben, z.B.  
192.168.0.1. Damit ist jeder Teilnehmer eindeutig identifizierbar. Gruppen von 
Teilnehmern werden über Broadcasts erreicht, wenn die Nummer 255 ist, z.B. 
172.16.100.255 entspricht den Teilnehmern 172.16.100.1 … 172.16.100.254 

IP-Netzmaske Netzmaske oder Netzwerkmaske, teils noch als Subnetzmaske bezeichnet. Eine 
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Bitmaske, die eine IP-Adresse in einen Netzwerk- und einen Geräte- bzw. Hostteil 
trennt. Sie wird in IP-Netzwerken verwendet, um Routing-Entscheidungen zu tref-
fen und Geräte zu bestimmten Gruppen zuzuordnen. Nur Geräte mit gleichem 
Netzwerkteil können direkt miteinander kommunizieren. 

IPX Internetwork Packet eXchange. Von Novell ursprünglich für das Netzwerkbe-
triebssystem NetWare eingeführtes Computer-Netzwerkprotokoll. Verlor seit An-
fang der 90er Jahre gegenüber TCP/IP zunehmend an Bedeutung. In der Licht-
technik werden IPX-Pakete nur vom AVAB/IPX - Lichtprotokoll verwendet. 

Licht-Protokoll Über Ethernet übertragenes Datenprotokoll, das Lichtinformationen überträgt. 
Lichtprotokolle sind herstellerspezifisch und meist nicht offengelegt (Ausnahmen: 
Art-Net, ACN). 

LTP Last Takes Precedence 

Form des Mergens von DMX-Daten: der zuletzt eingetroffene Wert von mehreren 
Eingängen bestimmt den Ausgabewert. Häufig verwendet von beweglicher Me-
chanik wie MovingLights. 

Multicast In der Netzwerktechnik Protokolle, die an mehrere Netzwerkteilnehmer oder 
Gruppen von Teilnehmern gesendet werden. Multicasts sind sehr effizient, weil 
die Teilnehmerfilterung bis auf gewisse Grenzen auf Hardwareebene geschieht 
und Unbeteiligte nicht belastet werden. Multicast-IP-Adressen haben einen eige-
nen Adressbereich, die MAC-Adresse wird von der IP-Adresse abgeleitet. 

In der Lichttechnik wird Multicast z.B. von ACN und ETCNet2 verwendet. 

Intelligente Switches leiten Multicastprotokolle nur zu Teilnehmern, die sich dafür 
beim Switch anmelden. Hierfür gibt es das IGMP-Protokoll. 

Profibus Der international am weitesten verbreitete Industrie-Feldbus, seinerzeit von einer 
Gruppe Hersteller unter Federführung von Siemens entwickelt, in Europa seit lan-
gem standardisiert durch IEC 61158/IEC 61784. Profibus ist physikalisch meist ei-
ne RS-485-Schnittstelle mit zeitlich determiniertem, Token-Ring-ähnlichem Proto-
koll. Genauso ist auch Lichtwellenleiter und Profinet (Industrial Ethernet) möglich. 
Es kann mehrere Master und Slaves sowie verschiedene Busprotokolle (FMS, 
DP,…) auf dem Bus geben. 

Dachorganisation PI International mit über 1500 Herstellern, in Deutschland 
durch die PNO vertreten. LSS ist Mitglied der PNO, alle LSS Profibusgeräte sind bei 
der PNO registriert. 

Profibus-DP Auf hohen Datendurchsatz und geringe Übertragungszeiten optimiertes Profi-
busprotokoll. Die Daten werden zyklisch und zeitlich determiniert übertragen, 
wobei ein Master jeweils bis zu 125 Slaves ansteuern kann. 

Profibus-DP ist in vielen Siemens S7-CPUs bereits als Standard-Schnittstelle ent-
halten und erfordert somit keinen weiteren Hardwareaufwand. 

RDM Remote Device Managment over DMX512 Networks 

American National Standard (ANSI) E1.20 der ESTA (Entertainment Services and 
Technology Association) 

Erlaubt eine bi-direktionale Übertragung auf dem DMX512-Bus zur Konfiguration, 
Diagnose und Rückmeldung intelligenter DMX-Geräte. 

Socket Schnittstelle zwischen Ethernet-Empfänger und Firmware des MasterPort RM. 
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Bezeichnet hier den Empfangs- und Sendepuffer für eine Subnet/Universe-
Kombination eines einzelnen Netzwerk-Senders. 

SPS Speicherprogrammierbare Steuerung (z.B: Siemens S7-300/400) 

Subnet In Lichtprotokollen mancher Hersteller einstellbare Netznummer, dem sich am 
Ethernet angeschlossene Geräte zuordnen lassen. Subnets dienen dazu, die 
Netzwerkstruktur übersichtlich zu gestalten. 

Nicht verwechseln mit IP-Netzmaske! 

TCP Transmission Control Protocol. Zuverlässiges Datenaustauschprotokoll für Com-
puternetzwerke, welches meist auf IP basiert und mit diesem zusammen als 
TCP/IP bezeichnet wird. Die Übertragung erfolgt verbindungsorientiert und gegen 
Übertragungsfehler gesichert. Wird bei Lichtnetzwerken für alle Arten des Daten-
austauschs zwischen Anlagen verwendet, wo es nicht so sehr auf Geschwindig-
keit, sondern auf Sicherheit ankommt. 

UDP User Datagram Protocol. Einfaches Netzwerkprotokoll, welches wie TCP meist auf 
IP basiert. Die Übertragung erfolgt verbindungslos und verlorengegangene Pakete 
werden nicht wiederholt. Ist dafür schneller und hat weniger Verwaltungsauf-
wand. Von vielen Lichtprotokollen für die Lichtdaten verwendet, wo es in erster 
Linie auf Geschwindigkeit und nicht auf Übertragungssicherheit ankommt, da die 
Daten zyklisch wiederholt werden. 

Universe Ethernet-Entsprechung einer DMX-Linie (512 Byte) 
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Anhang C 

Technische Daten 

Allgemeine technische Daten 

Bauart: Fertiggerät 
Abmessungen BxHxT: 19 Zoll Einbaugerät: 483 x 45 x 166mm (19‘‘, 1HE) 
 Portable:   273 x 127 x 229 mm 
Gewicht: 19 Zoll Einbaugerät: 1500g 
 Portable:   3500g 
EMV-Standards:   EN 55022, class B, FCC part 15, level B 
RoHS-conform:  ja 
Lieferumfang: 19 Zoll Einbaugerät: Gerät, Kaltgeräteanschlusskabel  
 Portable:   Gerät, Anschlusskabel mit Neutrik powerCon 
 
CPU/Frequenz: Altera Cyclone 3, max. 400 MHz 
 AMD Geode LX 800, max. 500MHz 
Stromversorgung:     200 – 240V AC, 50/60Hz oder  
     Power-over-Ethernet (IEEE 802.3af) 
 
Konfiguration: 19 Zoll Einbaugerät: LSS ConfigCore 
 Portable:   LSS ConfigCore und Menüsystem  
     mit Display und Encoder 
Leistungsaufnahme: 12W typ. 
Betriebstemperatur: 0° - 40°C 
Kühlung: 19 Zoll Einbaugerät: Bis 35°C Umgebungstemperatur passive  
     Kühlung, ab 50°C Gehäusetemperatur aktive, 
     temperaturgeregelte Kühlung 
 Portable:   passiv 
 
 

Schnittstellen 

DMX/RDM: Wahlweise  12x RJ45 (Neutrik EtherCon®), ESTA-Belegung 
     12x 5polig XLR 

Ports können einzeln als Ein- oder Ausgang in der Konfiguration definiert 
werden. Die Ports sind immer durch Optokoppler potentialgetrennt. 

 
DMX-IN/THRU: Wahlweise  1x RJ45 (Neutrik EtherCon®), ESTA-Belegung 
     1x 5polig XLR 
 Der Eingang ist immer durch Optokoppler potentialgetrennt. 
 
Ethernet:  RJ-45, IEEE-Belegung für 100BaseTx und  
  Power-over-Ethernet nach IEEE 802.3af 
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Netzwerk 

DMX 

Allgemein 
DMX-Protokoll: DMX-512  
Standards: USITT 1990, DIN 56930-2, ANSI E1.11 
Baudrate: 250 kbps 
Ausgänge: einzeln potentialgetrennt 
 (ISOLATED nach ANSI E1.11 A1) 
Potentialtrennung:    Optokoppler 
Isolationsspannung:    1000V DC 

Isolationswiderstand:    109  
EMV: Filterbeschaltung nach Stand der Technik an allen Ein- 

und Ausgängen 
Terminierung: werksseitig intern 
 

Empfang 

Startcode: =0    Lichtprotokoll (in Display ●) 

 <>0  kein Lichtprotokoll, RDM (in Display  R) 
minimale Protokolllänge: nur Startcode 
maximale Protokolllänge: Startcode + 512 Werte 
 (Werte über 512 gehen verloren) 

minimale Durchlaufverzögerung: 44 s 
maximale Durchlaufverzögerung: 22,5ms 
Empfangstimeout: 1…10s 
max. Abstand zwischen 2 Protokollen: 1…10s 

Minimale erkannte Breaklänge: 48 s 
Maximal zulässige Breaklänge: 1,95 s 
 

Senden 
Startcode: 0 
Protokolllänge: Startcode + 512 Werte 
Minimale Protokollzeit: 22,4ms 
Breaklänge: 90…999 µs (einstellbar) 
Mark After Break: 20…999 µs (einstellbar) 
Zusätzliche Pause nach Startcode: 25 µs 
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Ethernet 

Allgemeines 
Schnittstelle: 10/100 BaseT (IEEE 802.3u, 802.3x) 
Geschwindigkeit: 10 MBit/s, 100MBit/s; Autonegotiation 
Duplex-Mode: halb, voll; Autonegotiation 
 Auto-MDI/MDIX 
Anzeige: Link-LED, Data-LED, Geschwindigkeit und Duplex-Mode 

werden im Display angezeigt 
Lichtprotokolle: Art-Net (ArtisticLicence) 
 AVAB-IPX (AVAB, transtechnik, LDDE,…) 

 AVAB/UDP (transtechnik) 
 ShowNet (Strand Lighting) 

 sACN (ANSI E1.31) 
weitere Netzwerkprotokolle: ARP, IP, IPX, UDP, IGMPv2, TFTP, SLP v2, NetRDM 
 

Empfang 
Maximale Paketrate: >1000/s (bei 1 Lichtframe/Paket) 

Minimale Durchlaufverzögerung: 4 s 
Maximale Durchlaufverzögerung: 22,7 ms 
Max. Abstand zwischen 2 Protokollen: 1...999 s  (Halten per DMX-Out einstellbar) 
 
 

Senden 
Senderate bei Wertänderung: maximal aller 20 ms 
Senderate ohne Wertänderung: 20 ms … 4 s (einstellbar) 
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Anschlussbelegung 

DMX-Anschlüsse 

5 Pin XLR 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Data Ground 

2 Data - 

3 Data + 

4 Spare 

5 Spare  

 

PE kann über die Schirmung geführt werden 

 
 
 

RJ45 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Data + 

2 Data - 

3 Spare 

4  

5  

6 Spare 

7 Data Ground 

8 Data Ground 

S Kabelschirm 
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Ethernet 

Der Ethernet-Anschluss unterstützt Power-over-Ethernet nach IEEE 802.3af 

 

Pin Belegung 

1 Rx + 

2 Rx - 

3 Tx + 

4 V + 

5 V + 

6 Tx - 

7 V - 

8 V - 

S Kabelschirm 

 
 

Bestellnummer 

 

Modell Anschlüsse Bestellnummer 

MasterPort RM 19 Zoll RJ45 5062 

XLR 5162 

 

MasterPort RM portable RJ45 5262 

XLR 5362 

 

 


